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ロギングの概要
システムロギングは、デバイスから syslogデーモンを実行するサーバへのメッセージを収集
する方法です。中央のsyslogサーバへロギングは、ログおよびアラートの集約に役立ちます。
シスコデバイスでは、これらのログメッセージを UNIXスタイルの syslogサービスに送信で
きます。syslogサービスは、シンプルコンフィギュレーションファイルに従って、メッセー
ジを受信してファイルに保存するか、出力します。この形式のロギングは、保護された長期的

な保存場所をログに提供します。ログは、ルーチントラブルシューティングおよびインシデン

ト処理の両方で役立ちます。

ASAのシステムログにより、ASAのモニタリングおよびトラブルシューティングで必要な情報
を得ることができます。ロギング機能を使用して、次の操作を実行できます。

•ログに記録する syslogメッセージを指定する。

• Syslogメッセージの重大度のディセーブル化または変更

•次を含む、syslogメッセージ送信先となる、1つ以上の場所を指定する。

•内部バッファ

• 1台以上の syslogサーバ

• ASDM

• SNMP管理ステーション
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•指定の電子メールアドレス

•コンソール

• Telnetと SSHセッション

•重大度レベルやメッセージクラスなどによる、グループ内での syslogメッセージを設定
および管理する。

• syslogの生成にレート制限を適用するかどうかを指定する。

•内部ログバッファがいっぱいになった場合に、その内容に対して実行する処理（バッファ
を上書きする、バッファの内容を FTPサーバに送信する、または内容を内部フラッシュ
メモリに保存する）を指定する。

•場所、重大度レベル、クラス、またはカスタムメッセージリストにより、syslogメッセー
ジをフィルタリングする。

マルチコンテキストモードでのロギング

それぞれのセキュリティコンテキストには、独自のロギングコンフィギュレーションが含ま

れており、独自のメッセージが生成されます。システムコンテキストまたは管理コンテキスト

にログインし、別のコンテキストに変更した場合、セッションで表示されるメッセージは現在

のコンテキストに関連するメッセージに限定されます。

システム実行スペースで生成されるフェールオーバーメッセージなどの syslogメッセージは、
管理コンテキストで生成されるメッセージとともに管理コンテキストで表示できます。システ

ム実行スペースでは、ロギングの設定やロギング情報の表示はできません。

ASAは、各メッセージとともにコンテキスト名を含めるように設定できます。これによって、
単一のsyslogサーバに送信されるコンテキストメッセージを区別できます。この機能は、管理
コンテキストから送信されたメッセージとシステムから送信されたメッセージの判別にも役立

ちます。これが可能なのは、送信元がシステム実行スペースであるメッセージではシステムの

デバイス IDが使用され、管理コンテキストが送信元であるメッセージではデバイス IDとして
管理コンテキストの名前が使用されるからです。

syslogメッセージ分析
次に、さまざまなsyslogメッセージを確認することで取得できる情報タイプの例を示します。

• ASAセキュリティポリシーで許可された接続。これらのメッセージは、セキュリティポ
リシーで開いたままのホールを発見するのに役立ちます。

• ASAセキュリティポリシーで拒否された接続。これらのメッセージは、セキュアな内部
ネットワークに転送されているアクティビティのタイプを示します。

• ACE拒否率ロギング機能を使用すると、使用している ASAに対して発生している攻撃が
表示されます。
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• IDSアクティビティメッセージには、発生した攻撃が示されます。

•ユーザ認証とコマンドの使用により、セキュリティポリシーの変更を監査証跡することが
できます。

•帯域幅使用状況メッセージには、確立および切断された各接続のほか、使用された時間と
トラフィック量が示されます。

•プロトコル使用状況メッセージには、各接続で使用されたプロトコルとポート番号が示さ
れます。

•アドレス変換監査証跡メッセージは、確立または切断されている NATまたは PAT接続を
記録します。この情報は、内部ネットワークから外部に送信される悪意のあるアクティビ

ティのレポートを受信した場合に役立ちます。

syslogメッセージ形式
syslogメッセージはパーセントの記号（%）で始まり、次のように構造化されています。

%ASA Level Message_number: Message_text

次の表に、フィールドの説明を示します。

ASAが生成するメッセージの syslogメッセージファシリティコード。この
値は常に ASAです。

ASA

1～ 7。レベルは、syslogメッセージに記述されている状況の重大度を示し
ます。値が低いほどその状況の重大度は高くなります。

Level

syslogメッセージを特定する 6桁の固有の番号。Message_number

状況を説明するテキスト文字列。syslogメッセージのこの部分には、IPアド
レス、ポート番号、またはユーザ名が含まれていることがあります。

Message_text

重大度

次の表に、syslogメッセージの重大度の一覧を示します。それぞれの重大度にカスタムカラー
を割り当て、ASDMログビューアで重大度を識別しやすくできます。syslogメッセージの色設
定を行うには、[Tools] > [Preferences] > [Syslog]タブを選択するか、またはログビューア自体
のツールバーで [Color Settings]をクリックします。

表 1 : Syslogメッセージの重大度

説明重大度レベル番号

システムが使用不可能な状態。緊急0

すぐに措置する必要があります。アラート1
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説明重大度レベル番号

深刻な状況です。重大2

エラー状態です。エラー3

警告状態。警告4

正常ですが、注意を必要とする状況です。通知5

情報メッセージです。情報6

デバッグメッセージです。デバッグ7

ASAは、重大度 0（emergencies）の syslogメッセージを生成しません。（注）

syslogメッセージフィルタリング
生成される syslogメッセージは、特定の syslogメッセージだけが特定の出力先に送信されるよ
うにフィルタリングできます。たとえば、ASAを設定して、すべての syslogメッセージを 1つ
の出力先に送信し、それらのsyslogメッセージのサブセットを別の出力先に送信することがで
きます。

具体的には、syslogメッセージが次の基準に従って出力先に転送されるようにできます。

• syslogメッセージの ID番号

• syslogメッセージの重大度

• syslogメッセージクラス（機能エリアと同等）

これらの基準は、出力先を設定するときに指定可能なメッセージリストを作成して、カスタマ

イズできます。あるいは、メッセージリストとは無関係に、特定のメッセージクラスを各タ

イプの出力先に送信するようにASAを設定することもできます。

syslogメッセージクラス
syslogメッセージのクラスは次の 2つの方法で使用できます。

• syslogメッセージのカテゴリ全体の出力場所を指定します。

•メッセージクラスを指定するメッセージリストを作成します。

syslogメッセージクラスは、デバイスの特徴または機能と同等のタイプによって syslogメッ
セージを分類する方法を提供します。たとえば、RIPクラスは RIPルーティングを示します。
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特定のクラスに属する syslogメッセージの ID番号はすべて、最初の 3桁が同じです。たとえ
ば、611で始まるすべての syslogメッセージ IDは、vpnc（VPNクライアント）クラスに関連
付けられています。VPNクライアント機能に関連付けられている syslogメッセージの範囲は、
611101～ 611323です。

また、ほとんどの ISAKMPsyslogメッセージには先頭に付加されたオブジェクトの共通セット
が含まれているため、トンネルを識別するのに役立ちます。これらのオブジェクトは、使用可

能なときに、syslogメッセージの説明テキストの前に付加されます。syslogメッセージ生成時
にオブジェクトが不明な場合、特定の heading = valueの組み合わせは表示されません。

オブジェクトは次のように先頭に付加されます。

Group = groupname, Username = user, IP = IP_address

Groupはトンネルグループ、Usernameはローカルデータベースまたは AAAサーバから取得
したユーザ名、IPアドレスはリモートアクセスクライアントまたはレイヤ 2ピアのパブリッ
ク IPアドレスです。

次の表に、メッセージクラスと各クラスのメッセージ IDの範囲をリストします。

表 2 : syslogメッセージクラスおよび関連付けられているメッセージ ID番号

Syslogメッセージ ID番号定義クラス

109、113User Authenticationauth

106アクセスリスト—

415アプリケーションファイアウォール—

110、220トランスペアレントファイアウォールbridge

717PKI認証局ca

723Citrix Clientcitrix

747クラスタ—

323カード管理—

111、112、208、308コマンドインターフェイスconfig

724Secure Desktopcsd

776Cisco TrustSeccts

734ダイナミックアクセスポリシーdap

333、334ネットワークアドミッションコントロール

の EAPまたは EAPoUDP
eap、
eapoudp

336EIGRPルーティングeigrp
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Syslogメッセージ ID番号定義クラス

719電子メールプロキシ電子メール

735環境モニタリング—

101、102、103、104、105、210、
311、709

フェールオーバーha

746Identity-Basedファイアウォール—

400、733侵入検知システムids

750、751、752IKEv2ツールキット—

209、215、313、317、408IPスタックip

735IPアドレス割り当てipaa

400、401、420侵入防御システムips

325IPv6—

338ブラックリスト、ホワイトリスト、および

グレーリスト

—

444ライセンス—

802MDMプロキシmdm-proxy

731、732ネットワークアドミッションコントロールnac

731NACポリシーnacpolicy

732NACポリシーを適用する NAC設定nacsettings

713ネットワークアクセスポイント—

319ネットワークプロセッサnp

725NP SSL—

318、409、503、613OSPFルーティングospf

742パスワードの暗号化—

337電話プロキシ—

107、312RIPルーティングrip

321Resource Managerrm

120Smart Call Home—
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Syslogメッセージ ID番号定義クラス

106、108、201、202、204、302、
303、304、305、314、405、406、
407、500、502、607、608、609、
616、620、703、710

ユーザセッションsession

212SNMPsnmp

775ScanSafe—

725SSLスタックssl

722SSL VPNクライアントsvc

199、211、214、216、306、307、
315、414、604、605、606、610、
612、614、615、701、711、741

システムsys

733脅威の検出—

780トランザクションルールエンジンtre

339UC-IME—

779サービスタグスイッチングtag-switching

730VLANマッピングvm

213、403、603PPTPおよび L2TPセッションvpdn

316、320、402、404、501、602、
702、713、714、715

IKEおよび IPsecvpn

611VPNクライアントvpnc

720VPNフェールオーバーvpnfo

718VPNロードバランシングvpnlb

778VXLAN—

721WebVPNフェールオーバーwebfo

716WebVPNと AnyConnect Clientwebvpn

305NATおよび PAT—
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ログビューアのメッセージのソート

すべてのASDMログビューア（Real-Time Log Viewer、Log Buffer Viewer、および Latest ASDM
Syslog Events Viewer）でメッセージをソートできます。複数のカラムでテーブルをソートする
には、ソートの基準とする、最初のカラムのヘッダーをクリックし、Ctrlキーを押したまま、
同時にソート順に含める他のカラムのヘッダーをクリックします。時間順にメッセージをソー

トするには、日付と時刻のカラムを両方選択します。どちらか一方だけを選択した場合は、

（時刻に関係なく）日付のみまたは（日付に関係なく）時刻のみでメッセージがソートされま

す。

Real-Time Log Viewerおよび Latest ASDM Syslog Events Viewerでメッセージをソートすると、
記録された新しいメッセージは通常の表示位置となる一番上ではなく、ソートされた順序で表

示されます。つまり、メッセージはその他のメッセージの中に混ざって表示されます。

カスタムメッセージリスト

カスタムメッセージリストを作成して、送信する syslogメッセージとその出力先を柔軟に制
御できます。カスタムsyslogメッセージのリストで、次の条件のいずれかまたはすべてを使用
して syslogメッセージのグループを指定します。

•重大度

•メッセージ ID

• syslogメッセージ IDの範囲

•メッセージクラス

たとえば、メッセージリストを使用して次の操作を実行できます。

•重大度が 1および 2の syslogメッセージを選択し、1つ以上の電子メールアドレスに送信
する。

•メッセージクラス（「ha」など）に関連付けられたすべての syslogメッセージを選択し、
内部バッファに保存する。

メッセージリストには、メッセージを選択するための複数の基準を含めることができます。

ただし、メッセージ選択基準の追加は、それぞれ個別のコマンドエントリで行う必要がありま

す。重複したメッセージ選択基準を含むメッセージリストが作成される可能性もあります。

メッセージリストの2つの基準によって同じメッセージが選択される場合、そのメッセージは
一度だけログに記録されます。

クラスタ

syslogメッセージは、クラスタリング環境でのアカウンティング、モニタリング、およびトラ
ブルシューティングのための非常に重要なツールです。クラスタ内の各 ASAユニット（最大
8ユニットを使用できます）は、syslogメッセージを個別に生成します。特定の loggingコマン
ドを使用すると、タイムスタンプおよびデバイス IDを含むヘッダーフィールドを制御できま
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す。syslogサーバは、syslogジェネレータを識別するためにデバイス IDを使用します。logging
device-idコマンドを使用すると、同一または異なるデバイス ID付きで syslogメッセージを生
成することができ、クラスタ内の同一または異なるユニットからのメッセージのように見せる

ことができます。

クラスタの装置から syslogメッセージをモニタするには、モニタする各装置に対して ASDM
セッションを開く必要があります。

（注）

ロギングのガイドライン
この項では、ロギングを設定する前に確認する必要のある制限事項とガイドラインについて説

明します。

IPv6のガイドライン

IPv6はサポートされません。

その他のガイドライン

• syslogサーバでは、syslogdというサーバプログラムを実行する必要があります。Windows
では、オペレーティングシステムの一部として syslogサーバを提供しています。

• ASAが生成したログを表示するには、ロギングの出力先を指定する必要があります。ロギ
ングの出力先を指定せずにロギングをイネーブルにすると、ASAはメッセージを生成しま
すが、それらのメッセージは後で表示できる場所に保存されません。各ロギングの出力先

は個別に指定する必要があります。たとえば、出力先として複数のsyslogサーバを指定す
るには、各 syslogサーバの [Syslog Server]ペインで、個別のエントリを指定します。

•スタンドバイデバイスでは、TCP上での syslogの送信はサポートされません。

• 2つの異なるリストまたはクラスを、異なる syslogサーバまたは同じロケーションに割り
当てることはできません。

•最大 16台の syslogサーバを設定できます。ただし、マルチコンテキストモードでは、コ
ンテキストごとに 4サーバに制限されています。

• syslogサーバは、ASA経由で到達できなければなりません。syslogサーバが到達できるイ
ンターフェイス上で、デバイスが ICMP到達不能メッセージを拒否し、同じサーバにsyslog
を送信するように設定する必要があります。すべての重大度に対してロギングがイネーブ

ルであることを確認します。syslogサーバがクラッシュしないようにするため、syslog
313001、 313004、および 313005の生成を抑制します。

•アクセスリストのヒット数だけを照合するためにカスタムメッセージリストを使用する
と、ロギング重大度がデバッグ（レベル7）のアクセスリストに対しては、アクセスリス
トのログは生成されません。logging listコマンドのロギング重大度のデフォルトは、6に
設定されています。このデフォルト動作は設計によるものです。アクセスリストコンフィ
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ギュレーションのロギング重大度をデバッグに明示的に変更する場合は、ロギングコン

フィギュレーション自体も変更する必要があります。

ロギング重大度がデバッグに変更されたため、アクセスリストのヒットが含まれていない

show running-config loggingコマンドの出力例を次に示します。

ciscoasa# show running-config logging
logging enable
logging timestamp
logging list test message 106100
logging buffered test

次に、アクセスリストヒットを含む show running-config loggingコマンドの出力例を示し
ます。

ciscoasa# show running-config logging
logging enable
logging timestamp
logging buffered debugging

この場合、アクセスリストコンフィギュレーションは変更せず、アクセスリストヒット

数が次の例のように表示されます。

ciscoasa(config)# access-list global line 1 extended
permit icmp any host 4.2.2.2 log debugging interval 1 (hitcnt=7) 0xf36b5386
ciscoasa(config)# access-list global line 2 extended
permit tcp host 10.1.1.2 any eq www log informational interval 1 (hitcnt=18) 0xe7e7c3b8
ciscoasa(config)# access-list global line 3 extended
permit ip any any (hitcnt=543) 0x25f9e609

• ASAが TCP経由で syslogを送信すると、syslogdサービスの再起動後、接続の開始に約 1
分かかります。

ロギングの設定
ここでは、ロギングの設定方法について説明します。

ロギングのイネーブル化

ロギングをイネーブルにするには、次の手順を実行します。

手順

ステップ 1 ASDMで、次のいずれかを選択します。

• [Home] > [Latest ASDM Syslog Messages] > [Enable Logging ]
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• [Configuration] > [Device Management] > [Logging] > [Logging Setup]

• [Monitoring] > [Real-Time Log Viewer] > [Enable Logging]

• [Monitoring] > [Log Buffer] > [Enable Logging]

ステップ 2 [Enable logging]チェックボックスをオンにして、ロギングをオンにします。

出力先の設定

トラブルシューティングおよびパフォーマンスのモニタリング用にsyslogメッセージの使用状
況を最適化するには、syslogメッセージの送信先（内部ログバッファ、1つまたは複数の外部
syslogサーバ、ASDM、SNMP管理ステーション、コンソールポート、指定した電子メールア
ドレス、または Telnetおよび SSHセッションなど）を 1つまたは複数指定することをお勧め
します。

外部 syslogサーバへの syslogメッセージの送信

外部 syslogサーバで利用可能なディスク領域に応じてメッセージをアーカイブし、その保存
後、ロギングデータを操作できます。たとえば、特定タイプの syslogメッセージがログに記
録されたり、ログからデータが抽出されてレポート用の別のファイルにその記録が保存された

り、あるいはサイト固有のスクリプトを使用して統計情報が追跡されたりした場合に、特別な

アクションが実行されるように指定できます。

外部 syslogサーバに syslogメッセージを送信するには、次の手順を実行します。

手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [Logging Setup]を選択します。

ステップ 2 [Enable logging]チェックボックスをオンにして、ASAに対するロギングを有効にします。

ステップ 3 [Enable logging on the failover standby unit]チェックボックスをオンにして、スタンバイ ASAに
対するロギングを有効にします（可能な場合）。

ステップ 4 [Send debugmessages as syslogs]チェックボックスをオンにして、すべてのデバッグトレース出
力がシステムログにリダイレクトされるようにします。このオプションがイネーブルになって

いる場合、syslogメッセージはコンソールには表示されません。そのため、デバッグメッセー
ジを表示するには、コンソールでロギングをイネーブルにし、デバッグsyslogメッセージ番号
および重大度レベルの宛先としてコンソールを設定する必要があります。使用するsyslogメッ
セージ番号は、[711001]です。この syslogメッセージに対するデフォルトの重大度レベルは、
[Debugging]です。

ステップ 5 [Send syslogs in EMBLEM format]チェックボックスをオンにして、EMBLEM形式をイネーブル
にします。これにより、syslogサーバを除くロギングの宛先すべてに対して EMBLEM形式が
使用されます。

ステップ 6 ロギングバッファがイネーブルの場合、syslogメッセージを保存する内部ログバッファのサ
イズを指定します。バッファの空き容量がなくなると、FTPサーバまたは内部フラッシュメモ
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リにログを保存していない限り、メッセージは上書きされます。デフォルトのバッファサイズ

は 4096バイトです。有効な範囲は 4096～ 1048576です。

ステップ 7 バッファ内のデータが上書きされる前に、それらをFTPサーバに保存する場合は、[SaveBuffer
To FTP Server]チェックボックスをオンします。バッファ内のデータが上書きされるようにす
る場合は、このチェックボックスをオフにします。

ステップ 8 [Configure FTP Settings]をクリックして、FTPサーバを指定し、バッファ内のデータを保存す
る際に使用する FTPパラメータを設定します。

ステップ 9 [Save Buffer To Flash]チェックボックスをオンにして、上書きする前に内部フラッシュメモリ
にバッファの内容を保存します。

このオプションは、ルーテッドまたはトランスペアレントシングルモードだけで使

用できます。

（注）

ステップ 10 [Configure FlashUsage]をクリックし、ロギングに使用する内部フラッシュメモリの最大容量、
および最低限維持すべき空き容量をKB単位で指定します。このオプションをイネーブルにす
ると、メッセージが格納されるデバイスディスク上に、「syslog」という名前のディレクトリ
が作成されます。

このオプションは、単一ルーテッドモードまたはトランスペアレントモードでだけ

使用できます。

（注）

ステップ 11 ASAで表示するシステムログのキューサイズを指定します。

FTPの設定

ログバッファの内容の保存に使用するFTPサーバのコンフィギュレーションを指定するには、
次の手順を実行します。

手順

ステップ 1 [Enable FTP client]チェックボックスをオンにして、FTPクライアントのコンフィギュレーショ
ンをイネーブルにします。

ステップ 2 FTPサーバの IPアドレスを指定します。

ステップ 3 保存されるログバッファコンテンツの格納先となる FTPサーバ上のディレクトリパスを指定
します。

ステップ 4 FTPサーバにログインするためのユーザ名を指定します。

ステップ 5 FTPサーバへログインするためのユーザ名に関連付けられたパスワードを指定します。

ステップ 6 パスワードを確認し、[OK]をクリックします。
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ロギングに使用するフラッシュメモリの設定

ログバッファの内容を内部フラッシュメモリに保存する場合の制限事項を指定するには、次

の手順を実行します。

手順

ステップ 1 ロギングに使用できる内部フラッシュメモリの最大容量を指定します（KB単位）。

ステップ 2 維持する内部フラッシュメモリの容量を指定します（KB単位）。内部フラッシュメモリがこ
の制限値に近づくと、新しいログが保存されなくなります。

ステップ 3 [OK]をクリックして、[Configure Logging Flash Usage]ダイアログボックスを閉じます。

セキュアロギングの有効化

手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [Syslog Server]の順に選択します。

ステップ 2 セキュアロギングをイネーブルにする syslogサーバを選択し、[Edit]をクリックします。

[Edit Syslog Server]ダイアログボックスが表示されます。

ステップ 3 [TCP]オプションボタンをクリックします。

セキュアロギングでは UDPをサポートしていないため、このプロトコルを使用しようとする
とエラーが発生します。

ステップ 4 [Enable secure syslog with SSL/TLS]チェックボックスをオンにして、[OK]をクリックします。

syslogサーバに送信する EMBLEM形式の syslogメッセージの生成

syslogサーバへのEMBLEM形式の syslogメッセージを生成するには、次の手順を実行します。

手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [Syslog Server]の順に選択します。

ステップ 2 [Add]をクリックして、新しい syslogサーバを追加します。

[Add Syslog Server]ダイアログボックスが表示されます。

1つのセキュリティコンテキストに対して設定できる syslogサーバの数は最大で 4で
す（合計で 16まで）。

（注）
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ステップ 3 syslogサーバがビジー状態の場合、ASAでキューに入れることができるメッセージ数を指定し
ます。値がゼロの場合は、キューに入れられるメッセージ数が無制限になります。

ステップ 4 [Allow user traffic to pass when TCP syslog server is down]チェックボックスをオンにして、いず
れかのsyslogサーバがダウンした場合にすべてのトラフィックを制限するかどうかを指定しま
す。TCPを指定すると、ASAは syslogサーバの障害を検出し、セキュリティ保護として ASA
を経由する新しい接続をブロックします。UDPを指定すると、ASAは、syslogサーバが動作
しているかどうかに関係なく新しい接続を許可し続けます。有効なポート値は、どちらのプロ

トコルでも 1025～ 65535です。デフォルトのUDPポートは 514です。デフォルトの TCPポー
トは 1470です。

TCPでの syslogの送信は、スタンバイ ASAではサポートされていません。（注）

他の出力先への EMBLEM形式の syslogメッセージの生成

他の出力先への EMBLEM形式の syslogメッセージを生成するには、次の手順を実行します。

手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [Logging Setup]を選択します。

ステップ 2 [Send syslogs in EMBLEM format]チェックボックスをオンにします。

syslogサーバの設定の追加または編集

syslogサーバ設定を追加または編集するには、次の手順を実行します。

手順

ステップ 1 syslogサーバとの通信に使用するインターフェイスを、ドロップダウンリストから選択しま
す。

ステップ 2 syslogサーバとの通信に使用する IPアドレスを入力します。

syslogサーバが ASAまたは ASASMとの通信に使用するプロトコル（TCPまたは UDP）を選
択します。UDPまたは TCPのいずれかを使用して syslogサーバにデータを送信するように
ASAおよびASASMを設定することができます。プロトコルを指定しない場合、デフォルトの
プロトコルは UDPです。

ステップ 3 syslogサーバにおいて、ASAまたはASASMとの通信に使用されるポート番号を入力します。

ステップ 4 [Log messages in Cisco EMBLEM format (UDP only)]チェックボックスをオンにして、シスコの
EMBLEM形式でメッセージをログに記録するかどうかを指定します（プロトコルとして UDP
が選択されている場合に限る）。
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ステップ 5 [Enable secure logging using SSL/TLS (TCP only)]チェックボックスをオンにして、syslogサーバ
への接続がSSL/TLS over TCPの使用により保護され、syslogメッセージの内容が暗号化される
よう指定します。

ステップ 6 [OK]をクリックして設定を完了します。

内部ログバッファへの syslogメッセージの送信

一時的な保存場所となる内部ログバッファに送信する syslogメッセージを指定する必要があ
ります。新しいメッセージは、リストの最後に追加されます。バッファがいっぱいになったと

き、つまりバッファラップが発生した場合、ASAがいっぱいになったバッファを別の場所に
保存するように設定されていない限り、古いメッセージは生成される新しいメッセージによっ

て上書きされます。

syslogメッセージを内部ログバッファに送信するには、次の手順を実行します。

手順

ステップ 1 次のいずれかのオプションを選択して、内部ログバッファに送信する syslogメッセージを指
定します。

• [Home] > [Latest ASDM Syslog Messages] > [Configure ASDM Syslog Filters]

• [Configuration] > [Device Management] > [Logging] > [Logging Filters]

ステップ 2 [Monitoring] > [Logging] > [Log Buffer] > [View]の順に選択します。次に [Log Buffer]ペインで
[File] > [Clear Internal Log Buffer]の順に選択して、内部ログバッファを空にします。

ステップ 3 [Configuration] > [Device Management] > [Logging] > [Logging Setup]の順に選択して、内部ロ
グバッファのサイズを変更します。デフォルトのバッファサイズは 4 KBです。

ASAは、新しいメッセージを引き続き内部ログバッファに保存し、いっぱいになったログバッ
ファの内容を内部フラッシュメモリに保存します。バッファの内容を別の場所に保存すると

き、ASAは、次のタイムスタンプ形式を使用する名前でログファイルを作成します。

LOG-YYYY-MM-DD-HHMMSS.TXT

YYYYは年、MMは月、DDは日付、HHMMSSは時間、分、および秒で示された時刻です。

ステップ 4 別の場所に新しいメッセージを保存するには、次のオプションから 1つを選択します。

•内部フラッシュメモリに新しいメッセージを送信するには、[Flash]チェックボックスを
オンにして、[Configure Flash Usage]をクリックします。[Configure Logging Flash Usage]ダ
イアログボックスが表示されます。

1. ロギングに使用するフラッシュメモリの最大容量を KBで指定します。

2. ロギングをフラッシュメモリに保持する最小空き領域量を KBで指定します。
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3. [OK]をクリックして、このダイアログボックスを閉じます。

• FTPサーバに新しいメッセージを送信するには、[FTP Server]チェックボックスをオンに
し、[Configure FTP Settings]をクリックします。[Configure FTP Settings]ダイアログボック
スが表示されます。

1. [Enable FTP Client]チェックボックスをオンにします。

2. 表示されたフィールドに、FTPサーバ IPアドレス、パス、ユーザ名、パスワードを入
力します。

3. パスワードを確認し、[OK]をクリックしてこのダイアログボックスを閉じます。

内部ログバッファのフラッシュへの保存

内部ログバッファをフラッシュメモリに保存するには、次の手順を実行します。

手順

ステップ 1 [File] > [Save Internal Log Buffer to Flash]の順に選択します。

[Enter Log File Name]ダイアログボックスが表示されます。

ステップ 2 最初のオプションを選択し、LOG-YYYY-MM-DD-hhmmss.txt形式のデフォルトファイル名で
ログバッファを保存します。

ステップ 3 2番目のオプションを選択し、そのログバッファのファイル名を指定します。

ステップ 4 ログバッファのファイル名を入力して [OK]をクリックします。

ログの記録で使用可能な内部フラッシュメモリの容量の変更

ログの記録で使用可能な内部フラッシュメモリの容量を変更するには、次の手順を実行しま

す。

手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [Logging Setup]を選択します。

ステップ 2 [Enable Logging]チェックボックスをオンにします。

ステップ 3 [Logging to Internal Buffer]領域の [Save Buffer to Flash]チェックボックスをオンにします。

ステップ 4 [Configure Flash Usage]をクリックします。

[Configure Logging Flash Usage]ダイアログボックスが表示されます。

ステップ 5 ログインに使用できるフラッシュメモリの最大容量を KBで入力します。
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デフォルトでは、ASAは、内部フラッシュメモリの最大1MBをログデータに使用できます。
ASAでログデータを保存するために必要な内部フラッシュメモリの最小空き容量は 3 MBで
す。内部フラッシュメモリに保存されているログファイルにより、内部フラッシュメモリの

空き容量が設定された最小限の容量を下回ってしまう場合、ASAは最も古いログファイルを
削除し、新しいログファイルの保存後も最小限の容量が確保されるようにします。削除する

ファイルがない場合、または古いファイルをすべて削除しても空きメモリの容量が最小限の容

量を下回っている場合、ASAはその新しいログファイルを保存できません。

ステップ 6 フラッシュメモリにロギングするために維持する空き領域の最小容量を KBで入力します。

ステップ 7 [OK]をクリックして、[Configure Logging Flash Usage]ダイアログボックスを閉じます。

ASDM Java Consoleによる記録されたエントリの参照とコピー

ASDM Javaコンソールを使用して、ASDMエラーのトラブルシューティングに役立つ、記録
されたエントリをテキスト形式で表示およびコピーできます。

ASDM Java Consoleにアクセスするには、次の手順を実行します。

手順

ステップ 1 [Tools] > [ASDM Java Console]の順に選択します。

ステップ 2 コンソールで mと入力して、仮想マシンのメモリ統計情報を表示します。

ステップ 3 コンソールで gと入力して、ガベージコレクションを実行します。

ステップ 4 Windowsタスクマネージャを開き、asdm_launcher.exeファイルをダブルクリックして、メモ
リ使用量を監視します。

メモリ割り当ての最大値は 256 MBです。（注）

電子メールアドレスへの syslogメッセージの送信

syslogメッセージを電子メールアドレスに送信するには、次の手順を実行します。

手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [E-mail Setup]を選択します。

ステップ 2 電子メールメッセージとして送信される syslogメッセージの送信元アドレスとして使用する
電子メールアドレスを指定します。

ステップ 3 [Add]をクリックして、指定した syslogメッセージの受信者の電子メールアドレスを入力しま
す。

ステップ 4 その受信者に送信する syslogメッセージの重大度レベルを、ドロップダウンリストから選択
します。宛先の電子メールアドレスに対して適用される syslogメッセージの重大度フィルタ
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により、指定された重大度レベル以上のメッセージが送信されます。[LoggingFilters]ペインで
指定されたグローバルフィルタも、各電子メール受信者に適用されます。

ステップ 5 [Edit]をクリックして、この受信者へ送信する syslogメッセージの現在の重大度を変更します。

ステップ 6 [OK]をクリックして、[Add E-mail Recipient]ダイアログボックスを閉じます。

電子メール受信者の追加または編集

電子メールの受信者および重大度を追加または編集するには、次の手順を実行します。

手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [E-mail Setup]を選択します。

ステップ 2 [Add]または [Edit]をクリックして、[Add/Edit E-Mail Recipient]ダイアログボックスを表示しま
す。

ステップ 3 宛先の電子メールアドレスを入力し、ドロップダウンリストから syslog重大度を選択します。
重大度レベルは次のように定義されています。

• Emergency（レベル 0、システムが使用不能）

重要度レベル 0を使用することはお勧めできません。（注）

• Alert（レベル 1、即時対処が必要）

• Critical（レベル 2、クリティカル条件）

• Error（レベル 3、エラー条件）

• Warning（レベル 4、警告条件）

• Notification（レベル 5、正常だが顕著な条件）

• Informational（レベル 6、情報メッセージのみ）

• Debugging（レベル 7、デバッグメッセージのみ）

宛先電子メールアドレスへのメッセージをフィルタリングする場合は、[Add/Edit
E-Mail Recipient]ダイアログボックスで指定した重大度と、[Logging Filters]ペインで
すべての電子メール受信者に対して設定したグローバルフィルタの重大度のうち、上

位にある方が使用されます。

（注）

ステップ 4 [OK]をクリックして、[Add/Edit E-Mail Recipient]ダイアログボックスを閉じます。

追加または修正されたエントリが [E-mail Recipients]ペインに表示されます。

ステップ 5 [Apply]をクリックし、変更内容を実行コンフィギュレーションに保存します。

ロギング

18

ロギング

電子メール受信者の追加または編集



リモート SMTPサーバの設定

特定のイベントに対する電子メールアラートおよび通知の送信先となるリモート SMTPサー
バを設定するには、次の手順を実行します。

手順

ステップ 1 [Configuration] > [Device Setup] > [Logging] > [SMTP]の順に選択します。

ステップ 2 プライマリ SMTPサーバの IPアドレスを入力します。

ステップ 3 （任意）スタンバイ SMTPサーバの IPアドレスを入力し、[Apply]をクリックして変更内容を
実行コンフィギュレーションに保存します。

コンソールポートへの syslogメッセージの送信

syslogメッセージをコンソールポートに送信するには、次の手順を実行します。

手順

ステップ 1 次のいずれかのオプションを選択します。

• [Home] > [Latest ASDM Syslog Messages] > [Configure ASDM Syslog Filters]

• [Configuration] > [Device Management] > [Logging] > [Logging Filters]

ステップ 2 [Logging Destination]カラムでコンソールを選択し、[Edit]をクリックします。

[Edit Logging Filters]ダイアログボックスが表示されます。

ステップ 3 すべてのイベントクラスまたは特定のイベントクラスのいずれかから syslogを選択して、コ
ンソールポートに送信する syslogメッセージを指定します。

Telnetまたは SSHセッションへの syslogメッセージの送信

syslogメッセージを Telnetまたは SSHセッションに送信するには、次の手順を実行します。

手順

ステップ 1 次のいずれかのオプションを選択します。

• [Home] > [Latest ASDM Syslog Messages] > [Configure ASDM Syslog Filters]

• [Configuration] > [Device Management] > [Logging] > [Logging Filters]

ステップ 2 [Logging Destination]カラムの [Telnet and SSH Sessions]を選択し、[Edit]をクリックします。
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[Edit Logging Filters]ダイアログボックスが表示されます。

ステップ 3 すべてのイベントクラスまたは特定のイベントクラスのいずれかから syslogを選択して、
Telnetまたは SSHセッションに送信する syslogメッセージを指定します。

ステップ 4 [Configuration] > [Device Management] > [Logging] > [Logging Setup]の順に選択して、現在の
セッションのロギングだけをイネーブルにします。

ステップ 5 [Enable logging]チェックボックスをオンにし、[Apply]をクリックします。

syslogメッセージの設定

syslogメッセージの設定

syslogメッセージを設定するには、次の手順を実行します。

手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [Syslog Setup]の順に選択します。

ステップ 2 ファイルメッセージのベースとして使用する syslogサーバのシステムログ機能を選択します。
デフォルトは LOCAL(4)20です。これは、ほとんどの UNIXシステムで必要となるコードで
す。ただし、ネットワークデバイス間では8つのファシリティが共用されているため、システ
ムログではこの値を変更しなければならない場合があります。

ステップ 3 [Include timestamp in syslogs]チェックボックスをオンにして、送信される各 syslogメッセージ
に日付と時刻を追加します。

ステップ 4 ログイン試行が失敗した場合に無効なユーザ名を syslogメッセージに表示する場合は、[Hide
username if its validity cannot be determined]チェックボックスをオフにします。デフォルト設定
では、ユーザ名が無効な場合、または有効かどうか不明な場合、ユーザ名は非表示です。たと

えば、ユーザが誤ってユーザ名の代わりにパスワードを入力した場合、結果として生成される

syslogメッセージで「ユーザ名」を隠すのが安全です。ログインに関するトラブルシューティ
ングに役立てるために、無効なユーザ名を表示することもできます。

ステップ 5 [Syslog ID]テーブルに表示する情報を選択します。使用可能なオプションは、次のとおりで
す。

• [Syslog ID]テーブルにすべての syslogメッセージ IDを表示するように指定するには、
[Show all syslog IDs]を選択します。

• [Syslog ID]テーブルに明示的にディセーブルにした syslogメッセージ IDだけを表示する
ように指定するには、[Show disabled syslog IDs]を選択します。

• [Syslog ID]テーブルにデフォルト値から変更された重大度を含む syslogメッセージ IDだ
けを表示するように指定するには、[Show syslog IDs with changed logging]を選択します。

ロギング

20

ロギング

syslogメッセージの設定



• [Syslog ID]テーブルに重大度が変更された syslogメッセージ IDと、明示的にディセーブ
ルにされた syslogメッセージ IDだけを表示するように指定するには、[Show syslog IDs that
are disabled or with a changed logging level]を選択します。

ステップ 6 [Syslog ID Setup]テーブルには、その設定内容に基づいて、syslogメッセージのリストが表示
されます。変更する個々のメッセージ IDまたはメッセージ IDの範囲を選択します。選択した
メッセージ IDは、ディセーブルにすることも、その重大度レベルを変更することもできます。
リストから複数のメッセージ IDを選択する場合は、その範囲の先頭にあたる IDを選択し、
Shiftキーを押しながらその範囲の最後にあたる IDをクリックします。

ステップ 7 syslogメッセージにデバイス IDが含まれるよう設定する場合は、[Advanced]をクリックしま
す。

syslog ID設定の編集

syslogメッセージの設定を変更するには、次の手順を実行します。

[Syslog ID(s)]フィールドは表示専用です。この領域に表示される値は、[SyslogSetup]ペインに
ある [Syslog ID]テーブルで選択されたエントリにより決まります。

（注）

手順

ステップ 1 [Disable Message(s)]チェックボックスをオンにして、[Syslog ID(s)]リストに IDが表示されて
いる syslogメッセージをディセーブルにします。

ステップ 2 [Syslog ID(s)]リストに表示される syslogメッセージ IDに送信するメッセージの重大度のロギ
ングレベルを選択します。重大度レベルは次のように定義されています。

• Emergency（レベル 0、システムが使用不能）

重要度レベル 0を使用することはお勧めできません。（注）

• Alert（レベル 1、即時対処が必要）

• Critical（レベル 2、クリティカル条件）

• Error（レベル 3、エラー条件）

• Warning（レベル 4、警告条件）

• Notification（レベル 5、正常だが顕著な条件）

• Informational（レベル 6、情報メッセージのみ）

• Debugging（レベル 7、デバッグメッセージのみ）
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ステップ 3 [OK]をクリックして [Edit Syslog ID Settings]ダイアログボックスを閉じます。

非 EMBLEM形式の syslogメッセージへのデバイス IDの出力

デバイス IDを非 EMBLEM形式の syslogメッセージに含めるには、次の手順を実行します。

手順

ステップ 1 [Enable syslog device ID]チェックボックスをオンにして、非 EMBLEM形式の syslogメッセー
ジすべてにデバイス IDが含まれるように指定します。

ステップ 2 次のいずれかのオプションを選択して、どのようなデバイス IDを使用するかを指定します。

• ASAのホスト名

•インターフェイス IPアドレス

選択した IPアドレスに対応するインターフェイス名を、ドロップダウンリストから選択
します。

クラスタリングを使用する場合は、[In an ASA cluster, always use master’s IP address for the
selected interface]チェックボックスをオンにします。

•文字列

英数字のユーザ定義文字列を入力します。

• ASAクラスタ名

ステップ 3 [OK]をクリックして、[Advanced Syslog Configuration]ダイアログボックスを閉じます。

syslogメッセージに日付と時刻を含める

syslogメッセージに日付と時刻を含めるには、次の手順を実行します。

手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [Syslog Setup]の順に選択します。

ステップ 2 [Syslog ID Setup]領域で [Include timestamp in syslogs]チェックボックスをオンにします。

ステップ 3 [Apply]をクリックして変更内容を保存します。

syslogメッセージの無効化

指定した syslogメッセージをディセーブルにするには、次の手順を実行します。
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手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [Syslog Setup]の順に選択します。

ステップ 2 テーブルからディセーブルにする syslogを選択して、[Edit]をクリックします。

[Edit Syslog ID Settings]ダイアログボックスが表示されます。

ステップ 3 [Disable messages]チェックボックスをオンにし、[OK]をクリックします。

syslogメッセージの重大度の変更

syslogメッセージの重大度を変更するには、次の手順を実行します。

手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [Syslog Setup]の順に選択します。

ステップ 2 重大度を変更する syslogをテーブルから選択して、[Edit]をクリックします。

[Edit Syslog ID Settings]ダイアログボックスが表示されます。

ステップ 3 適切な重大度を [Logging Level]ドロップダウンリストから選択し、[OK]をクリックします。

スタンバイ装置の syslogメッセージのブロック

スタンバイ装置で特定のsyslogメッセージが生成されないようにするには、次の手順を実行し
ます。

手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [Syslog Settings]の順に選択します。

ステップ 2 テーブルの syslog IDを選択し、[Edit]をクリックします。

[Edit Syslog ID Settings]ダイアログボックスが表示されます。

ステップ 3 スタンバイ装置で syslogメッセージが生成されないようにするには、[Disablemessageson standby
unit]チェックボックスをオンにします。

ステップ 4 [OK]をクリックして、このダイアログボックスを閉じます。

非 EMBLEM形式の syslogメッセージにデバイス IDを含める

デバイス IDを非 EMBLEM形式の syslogメッセージに含めるには、次の手順を実行します。
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手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [Syslog Setup] > [Advanced] > [Advanced
Syslog Configuration]の順に選択します。

ステップ 2 [Enable syslog device ID]チェックボックスをオンにします。

ステップ 3 [Device ID]領域で、[Hostname]、[Interface IPAddress]または [String]オプションボタンをクリッ
クします。

• [Interface IP Address]オプションを選択した場合は、ドロップダウンリストで正しいイン
ターフェイスが選択されていることを確認します。

• [String]オプションを選択した場合は、[User-Defined ID]フィールドにデバイス IDを入力
します。文字列の長さは、最大で 16文字です。

イネーブルにすると、EMBLEM形式の syslogメッセージや SNMPトラップにデバイ
ス IDは表示されません。

（注）

ステップ 4 [OK]をクリックして、[Advanced Syslog Configuration]ダイアログボックスを閉じます。

カスタムイベントリストの作成

イベントリストの定義には、次の 3つの基準を使用します。

•イベントクラス

•重大度

•メッセージ ID

特定のロギングの宛先（SNMPサーバなど）に送信するカスタムイベントリストを作成する
には、次の手順を実行します。

手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [Event Lists]の順に選択します。

ステップ 2 [Add]をクリックして、[Add Event List]ダイアログボックスを表示します。

ステップ 3 イベントリストの名前を入力します。スペースは使用できません。

ステップ 4 [Add]をクリックして、[Add Class and SeverityFilter]ダイアログボックスを表示します。

ステップ 5 ドロップダウンリストからイベントクラスを選択します。使用できるイベントクラスは、使

用しているデバイスモードによって異なります。

ステップ 6 ドロップダウンリストから重大度レベルを選択します。重大度レベルは次のとおりです。

• Emergency（レベル 0、システムが使用不能）
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重要度レベル 0を使用することはお勧めできません。（注）

• Alert（レベル 1、即時対処が必要）

• Critical（レベル 2、クリティカル条件）

• Error（レベル 3、エラー条件）

• Warning（レベル 4、警告条件）

• Notification（レベル 5、正常だが顕著な条件）

• Informational（レベル 6、情報メッセージのみ）

• Debugging（レベル 7、デバッグメッセージのみ）

ステップ 7 [OK]をクリックして、[Add Event List]ダイアログボックスを閉じます。

ステップ 8 [Add]をクリックして、[Add Syslog Message ID Filter]ダイアログボックスを表示します。

ステップ 9 フィルタに含める syslogメッセージ IDまたは syslogメッセージ IDの範囲（101001～ 199012
など）を入力します。

ステップ 10 [OK]をクリックして、[Add Event List]ダイアログボックスを閉じます。

目的のイベントがリストに表示されます。

ロギングフィルタの設定

ロギングの宛先へのメッセージフィルタの適用

ロギングの宛先にメッセージフィルタを適用するには、次の手順を実行します。

手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [Logging Filters]を選択します。

ステップ 2 フィルタを適用するロギングの宛先の名前を選択します。選択できるロギングの宛先は次のと
おりです。

• ASDM

•コンソールポート

•電子メール

•内部バッファ

• SNMPサーバ

• Syslogサーバ
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• Telnetまたは SSHセッション

このほか、2番目のカラム [Syslogs From All Event Classes]と 3番目のカラム [Syslogs From
Specific Event Classes]でも選択操作を行います。2番目のカラムでは、ロギングの宛先へ
のメッセージをフィルタリングする場合に使用する重大度やイベントクラスが表示される

ほか、すべてのイベントクラスに対してロギングをディセーブルにするかを選択すること

もできます。3番目のカラムには、選択したロギングの宛先へのメッセージをフィルタリ
ングする場合に使用するイベントクラスが表示されます。

ステップ 3 [Edit]をクリックして、[Edit Logging Filters]ダイアログボックスを表示します。フィルタを適
用、編集、またはディセーブルにする手順については、ロギングフィルタの適用（26ペー
ジ）を参照してください。

ロギングフィルタの適用

フィルタを適用するには、次の手順を実行します。

手順

ステップ 1 重大度レベルに基づいて syslogメッセージのフィルタリングを行う場合は、[Filter on severity]
オプションを選択します。

ステップ 2 イベントリストに基づいて syslogメッセージのフィルタリングを行う場合は、[Use event list]
オプションを選択します。

ステップ 3 選択した宛先に対するロギングをすべてディセーブルにする場合は、[Disable logging from all
event classes]オプションを選択します。

ステップ 4 [New]をクリックして、新しいイベントリストを追加します。イベントリストを新たに追加
する手順については、カスタムイベントリストの作成（24ページ）を参照してください。

ステップ 5 ドロップダウンリストからイベントクラスを選択します。使用できるイベントクラスは、使
用しているデバイスモードによって異なります。

ステップ 6 ドロップダウンリストから、ロギングメッセージの重大度レベルを選択します。重大度レベ
ルは次のとおりです。

• Emergency（レベル 0、システムが使用不能）

重要度レベル 0を使用することはお勧めできません。（注）

• Alert（レベル 1、即時対処が必要）

• Critical（レベル 2、クリティカル条件）

• Error（レベル 3、エラー条件）

• Warning（レベル 4、警告条件）

• Notification（レベル 5、正常だが顕著な条件）
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• Informational（レベル 6、情報メッセージのみ）

• Debugging（レベル 7、デバッグメッセージのみ）

ステップ 7 [Add]をクリックして、イベントクラスおよび重大度レベルを追加し、[OK]をクリックしま
す。

ダイアログボックスの上部には、フィルタに対して選択したロギングの宛先が表示されます。

syslogメッセージ IDフィルタの追加または編集

syslogメッセージ IDフィルタを作成または編集する手順については、syslog ID設定の編集（
21ページ）を参照してください。

メッセージクラスと重大度フィルタの追加または編集

メッセージのフィルタリングに使用するメッセージクラスおよび重大度レベルを追加または編

集するには、次の手順を実行します。

手順

ステップ 1 ドロップダウンリストからイベントクラスを選択します。使用できるイベントクラスは、使
用しているデバイスモードによって異なります。

ステップ 2 ドロップダウンリストから、ロギングメッセージの重大度レベルを選択します。重大度レベ
ルは次のとおりです。

• Emergency（レベル 0、システムが使用不能）

重要度レベル 0を使用することはお勧めできません。（注）

• Alert（レベル 1、即時対処が必要）

• Critical（レベル 2、クリティカル条件）

• Error（レベル 3、エラー条件）

• Warning（レベル 4、警告条件）

• Notification（レベル 5、正常だが顕著な条件）

• Informational（レベル 6、情報メッセージのみ）

• Debugging（レベル 7、デバッグメッセージのみ）

ステップ 3 選択が終了したら、[OK]をクリックします。
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指定した出力先へのクラス内のすべての syslogメッセージの送信

クラス内のすべてのsyslogメッセージを指定した出力先に送信するには、次の手順を実行しま
す。

手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [Logging Filters]を選択します。

ステップ 2 指定した出力先の設定をオーバーライドするには、変更する出力先を選択してから [Edit]をク
リックします。

[Edit Logging Filters]ダイアログボックスが表示されます。

ステップ 3 [Syslogs from All Event Classes]または [Syslogs from Specific Event Classes]領域のいずれかで設
定を変更し、[OK]をクリックしてこのダイアログボックスを閉じます。

たとえば、重大度 7のメッセージが内部ログバッファに送信されるように指定し、重大度 3の
haクラスのメッセージが内部ログバッファに送信されるように指定すると、後のコンフィギュ
レーションが優先されます。

1つのクラスが複数の出力先に送信されるように指定する場合は、出力先ごとに異なるフィル
タリングオプションを選択します。

syslogメッセージの生成レートの制限
syslogメッセージの生成レートを制限するには、次の手順を実行します。

手順

ステップ 1 [Configuration] > [Device Management] > [Logging] > [Rate Limit]を選択します。

ステップ 2 レート制限を割り当てるロギングレベル（メッセージの重大度）を選択します。重大度レベル
は次のように定義されています。

• Emergency（レベル 0、システムが使用不能）

• Alert（レベル 1、即時対処が必要）

• Critical（レベル 2、クリティカル条件）

• Error（レベル 3、エラー条件）

• Warning（レベル 4、警告条件）

• Notification（レベル 5、正常だが顕著な条件）

• Informational（レベル 6、情報メッセージのみ）
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• Debugging（レベル 7、デバッグメッセージのみ）

ステップ 3 送信されるメッセージの数が [No of Messages]フィールドに表示されます。また、選択したロ
ギングレベルで送信できるメッセージ数を制限する際の基準となる時間間隔（秒単位）が

[Interval (Seconds)]フィールドに表示されます。テーブルからロギングレベルを選択し、[Edit]
をクリックして [Edit Rate Limit for Syslog Logging Level]ダイアログボックスを表示します。

ステップ 4 以降の手順については、個々の syslogメッセージに対するレート制限の割り当てまたは変更
（29ページ）を参照してください。

個々の syslogメッセージに対するレート制限の割り当てまたは変更

個々のsyslogメッセージにレート制限を割り当てる、またはメッセージごとにレート制限を変
更するには、次の手順を実行します。

手順

ステップ 1 特定の syslogメッセージにレート制限を割り当てる場合は、[Add]をクリックして、[Add Rate
Limit for Syslog Message]ダイアログボックスを表示します。

ステップ 2 以降の手順については、syslogメッセージに対するレート制限の追加または編集（29ページ）
を参照してください。

ステップ 3 特定の syslogメッセージに対するレート制限を変更する場合は、[Edit]をクリックして、[Edit
Rate Limit for Syslog Message]ダイアログボックスを表示します。

ステップ 4 以降の手順については、syslog重大度に対するレート制限の編集（30ページ）を参照してく
ださい。

syslogメッセージに対するレート制限の追加または編集

特定のsyslogメッセージに対するレート制限を追加または変更するには、次の手順を実行しま
す。

手順

ステップ 1 特定の syslogメッセージに対するレート制限を追加する場合は、[Add]をクリックして、[Add
Rate Limit for Syslog Message]ダイアログボックスを表示します。特定の syslogメッセージに対
するレート制限を変更する場合は、[Edit]をクリックして、[Edit Rate Limit for Syslog Message]
ダイアログボックスを表示します。

ステップ 2 レートを制限する syslogメッセージの IDを入力します。

ステップ 3 指定した時間内に送信できるメッセージの最大数を入力します。

ステップ 4 指定したメッセージのレートを制限する際の基準となる時間間隔を秒単位で入力し、[OK]を
クリックします。
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メッセージ数を制限なしにする場合は、[Number ofMessages]フィールドおよび [Time
Interval]フィールドをともにブランクのままにします。

（注）

syslog重大度に対するレート制限の編集

指定した syslog重大度のレート制限を変更するには、次の手順を実行します。

手順

ステップ 1 指定した重大度で送信可能なメッセージの最大数を指定します。

ステップ 2 指定した重大度のメッセージに対するレートを制限する基準となる時間間隔を秒単位で入力
し、[OK]をクリックします。

選択したメッセージ重大度が表示されます。

メッセージ数を制限なしにする場合は、[Number ofMessages]フィールドおよび [Time
Interval]フィールドをともにブランクのままにします。

（注）

ログのモニタリング
ロギングステータスの監視については、次のコマンドを参照してください。

• [Monitoring] > [Logging] > [Log Buffer] > [View]

このペインでは、ログバッファを表示できます。

• [Monitoring] > [Logging] > [Real-Time Log Viewer] > [View]

このペインでは、リアルタイムのログを表示できます。

• [Tools] > [Command Line Interface]

このペインでは、さまざまな非インタラクティブコマンドを発行し、結果を表示すること

ができます。

ログビューアを使用した syslogメッセージのフィルタリング
Real-Time Log Viewerおよび Log Buffer Viewerの任意のカラムに対応する 1つ以上の値に基づ
いて、syslogメッセージをフィルタリングできます。

ログビューアのいずれかを使用して syslogメッセージをフィルタリングするには、次の手順
を実行します。
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手順

ステップ 1 次のいずれかのオプションを選択します。

• [Monitoring] > [Logging] > [Real-Time Log Viewer] > [View]

• [Monitoring] > [Logging] > [Log Buffer] > [View]

ステップ 2 [Real-Time Log Viewer]または [Log Buffer Viewer]ダイアログボックスのいずれかで、ツール
バーの [Build Filter]をクリックします。

ステップ 3 [Build Filter]ダイアログボックスで、syslogメッセージに適用するフィルタリング基準を指定
します。

a) [Date and Time]領域で、リアルタイム、特定時刻、時間範囲の 3つのオプションから 1つ
を選択します。特定時刻を選択した場合は、数値を入力してドロップダウンリストから時

または分を選択し、時刻を指定します。時間範囲を選択した場合、[Start Time]フィールド
のドロップダウン矢印をクリックすると、カレンダーが表示されます。ドロップダウンリ

ストから開始日と開始時刻を選択し、[OK]をクリックします。[End Time]フィールドのド
ロップダウン矢印をクリックすると、カレンダーが表示されます。ドロップダウンリスト

から終了日と終了時刻を選択し、[OK]をクリックします。
b) [Severity]フィールドに有効な重大度を入力します。または、[Severity]フィールドの右側
で [Edit]アイコンをクリックします。フィルタリングする重大度をリストでクリックしま
す。重大度 1～ 7を含めるには、[All]をクリックします。[OK]をクリックして、これら
の設定を [Build Filter]ダイアログボックスに表示します。使用する正しい入力形式に関す
る詳細な情報については、[Severity]フィールドの右側にある [Info]アイコンをクリックし
ます。

c) [Syslog ID]フィールドに有効な syslog IDを入力します。または、[Syslog ID]フィールドの
右側の [Edit]アイコンをクリックします。ドロップダウンリストからフィルタ対象の条件
を選択し、[Add]をクリックします。[OK]をクリックして、これらの設定を [Build Filter]
ダイアログボックスに表示します。使用する正しい入力形式に関する詳細な情報について

は、[Syslog ID]フィールドの右側にある [Info]アイコンをクリックします。
d) [Source IP Address]フィールドに有効な送信元 IPアドレスを入力するか、または [Source IP

Address]フィールドの右側で [Edit]アイコンをクリックします。単一の IPアドレスまたは
IPアドレスの特定の範囲を選択し、[Add]をクリックします。特定の IPアドレスまたは IP
アドレスの範囲を除外するには、[Do not include (exclude) this address or range]チェックボッ
クスをオンにして、[OK]をクリックし、[Build Filter]ダイアログボックスにこれらの設定
を表示します。使用する正しい入力形式に関する詳細な情報については、[Source IPAddress]
フィールドの右側にある [Info]アイコンをクリックします。

e) [Source Port]フィールドに有効な送信元ポートを入力するか、または [Source Port]フィー
ルドの右側の [Edit]アイコンをクリックします。ドロップダウンリストからフィルタ対象
の条件を選択し、[Add]をクリックします。[OK]をクリックして、これらの設定を [Build
Filter]ダイアログボックスに表示します。使用する正しい入力形式に関する詳細な情報に
ついては、[Source Port]フィールドの右側にある [Info]アイコンをクリックします。

f) [Destination IPAddress]フィールドに有効な宛先 IPアドレスを入力するか、または [Destination
IP Address]フィールドの右側で [Edit]アイコンをクリックします。単一の IPアドレスまた
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は IPアドレスの特定の範囲を選択し、[Add]をクリックします。特定の IPアドレスまたは
IPアドレスの範囲を除外するには、[Do not include (exclude) this address or range]チェック
ボックスをオンにします。[OK]をクリックして、これらの設定を [Build Filter]ダイアログ
ボックスに表示します。使用する正しい入力形式に関する詳細な情報については、[Destination
IP Address]フィールドの右側にある [Info]アイコンをクリックします。

g) [Destination Port]フィールドに有効な宛先ポートを入力するか、または [Destination Port]
フィールドの右側の [Edit]アイコンをクリックします。ドロップダウンリストからフィル
タ対象の条件を選択し、[Add]をクリックします。[OK]をクリックして、これらの設定を
[Build Filter]ダイアログボックスに表示します。使用する正しい入力形式に関する詳細な
情報については、[Destination Port]フィールドの右側にある [Info]アイコンをクリックしま
す。

h) [Description]フィールドにフィルタリングテキストを入力します。このテキストには、正
規表現を含む、1つ以上の文字からなる任意の文字列を指定できます。ただし、セミコロ
ンは有効な文字ではありません。また、この設定では大文字と小文字が区別されます。複

数のエントリを指定する場合は、カンマで区切ります。

i) [OK]をクリックして、指定したフィルタリング設定をログビューアの [Filter By]ドロップ
ダウンリストに追加します。フィルタ文字列は特定の形式に従います。FILTER:プレフィッ
クスは、[Filter By]ドロップダウンリストに表示されるすべてのカスタムフィルタを示し
ます。このフィールドにはランダムなテキストを入力することもできます。

次の表に、使用される形式の例を示します。

フィルタ文字列形式Build Filterの例

FILTER: srcIP=192.168.1.1,0.0.0.0;srcPort=67;Source IP = 192.168.1.1または 0.0.0.0

Source Port = 67

FILTER: sev=6;dstIP=1.1.1.1-1.1.1.10;Severity = Informational

Destination IP = 1.1.1.1～ 1.1.1.10

FILTER: sysID=!725001-725003;725001～ 725003の範囲外の syslog ID

FILTER: srcIP=1.1.1.1;descr=Built outboundSource IP = 1.1.1.1

Description = Built outbound

ステップ 4 [Filter By]ドロップダウンリストの設定の 1つを選択し、ツールバーの [Filter]をクリックし
て、syslogメッセージをフィルタリングします。この設定は、これ以降のすべての syslogメッ
セージにも適用されます。すべてのフィルタをクリアするには、ツールバーにある [Show All]
をクリックします。

[Build Filter]ダイアログボックスを使用して指定したフィルタは保存できません。こ
れらのフィルタは、そのフィルタが作成された ASDMセッションのみで有効です。

（注）
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フィルタリング設定の編集

[Build Filter]ダイアログボックスを使用して作成したフィルタリング設定を編集するには、次
の手順を実行します。

手順

次のいずれかのオプションを選択します。

• [Filter By] ドロップダウンリストで変更を入力して、フィルタを直接修正します。

• [Filter By]ドロップダウンリストでフィルタを選択し、[Build Filter]をクリックして [Build
Filter]ダイアログボックスを表示します。[Clear Filter]をクリックして、現在のフィルタ設
定を削除し、新しい値を入力します。それ以外の場合は、表示された設定を変更して [OK]
をクリックします。

これらのフィルタリング設定は、[Build Filter]ダイアログボックスで定義された
フィルタのみに適用されます。

（注）

•ツールバーの [Show All]をクリックすると、フィルタリングが停止し、すべての syslog
メッセージが表示されます。

ログビューアを使用した特定のコマンドの発行

いずれかのログビューアを使用して、ping、traceroute、whois、およびdns lookupコマンドを
発行できます。

これらのコマンドのいずれかを実行するには、次の手順を実行します。

手順

ステップ 1 次のいずれかのオプションを選択します。

• [Monitoring] > [Logging] > [Real-Time Log Viewer] > [View]

• [Monitoring] > [Logging] > [Log Buffer] > [View]

ステップ 2 [Real-Time Log Viewer]または [Log Buffer]ペインから [Tools]をクリックし、実行するコマン
ドを選択します。または、表示された特定のsyslogメッセージを右クリックしてコンテキスト
メニューを表示し、実行するコマンドを選択します。

[Entering command]ダイアログボックスが表示され、選択したコマンドが自動的にドロップダ
ウンリストに表示されます。
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ステップ 3 選択した syslogメッセージの送信元 IPアドレスまたは宛先 IPアドレスのいずれかを [Address]
フィールドに入力し、[Go]をクリックします。

指定した領域にコマンド出力が表示されます。

ステップ 4 [Clear]をクリックして出力を削除し、実行する別のコマンドをドロップダウンリストから選
択します。必要に応じてステップ 3を繰り返します。完了したら [Close]をクリックします。

ロギングの履歴
表 3 :ロギングの履歴

説明プラットフォームリリース機能名

さまざまな出力先を経由してASAネッ
トワークロギング情報を提供します。

ログファイルを表示して保存するオプ

ションも含まれています。

次の画面が導入されました。
[Configuration] > [Device Management] >
[Logging] > [Logging Setup]。

7.0(1)Logging

syslogメッセージが生成されるレート
を制限します。

次の画面が変更されました。
[Configuration] > [Device Management] >
[Logging] > [Rate Limit]。

7.0(4)レート制限

さまざまな基準（ロギングレベル、イ

ベントクラス、およびメッセージ ID）
でメッセージを指定するために他のコ

マンドで使用されるロギングリストを

作成します。

次の画面が変更されました。
[Configuration] > [Device Management] >
[Logging] > [Event Lists]。

7.2(1)ロギングリスト
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説明プラットフォームリリース機能名

リモートロギングホストへの接続に

SSL/TLSを使用するように指定しま
す。このオプションは、選択されたプ

ロトコルが TCPの場合にだけ有効で
す。

次の画面が変更されました。
[Configuration] > [Device Management] >
[Logging] > [Syslog Server]。

8.0(2)セキュアロギング

ロギングメッセージの ipaaイベント
クラスに対するサポートが追加されま

した。

次の画面が変更されました。
[Configuration] > [Device Management] >
[Logging] > [Logging Filters]。

8.0(4)、8.1(1)ロギングクラス

ロギングメッセージの dapイベント
クラスに対するサポートが追加されま

した。

保存されたロギングバッファ

（ASDM、内部、FTP、およびフラッ
シュ）をクリアする追加サポート。

次の画面が変更されました。
[Configuration] > [Device Management] >
[Logging] > [Logging Setup]。

8.2(1)ロギングクラスと保存されたロギング

バッファ

パスワードの暗号化に対するサポート

が追加されました。

8.3(1)パスワードの暗号化

送信元 IPアドレスおよび宛先 IPアド
レスがログビューアに追加されまし

た。

8.3(1)ログビューア

ロギング

35

ロギング

ロギングの履歴



説明プラットフォームリリース機能名

TCPを使用するように syslogサーバを
設定すると、syslogサーバを使用でき
ない場合、ASAはサーバが再び使用可
能になるまで syslogメッセージを生成
する新しい接続をブロックします（た

とえば、VPN、ファイアウォール、
カットスループロキシ接続）。この機

能は、ASAのロギングキューがいっ
ぱいのときにも新しい接続をブロック

するように拡張されました。接続は、

ロギングキューがクリアされると再開

されます。

この機能は、Common Criteria EAL4+
への準拠のために追加されました。必

要でない限り、syslogメッセージを送
受信できない場合でも接続を許可する

ことを推奨します。接続を許可するに

は、[Configuration] > [Device
Management] > [Logging] > [Syslog
Servers]ペインで [Allow user traffic to
pass when TCP syslog server is down]
チェックボックスをオンにします。

414005、414006、414007、414008の各
syslogメッセージが導入されました。

変更されたASDM画面はありません。

8.3(2)拡張ロギングと接続ブロック
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説明プラットフォームリリース機能名

次のサポートが追加されました。

•さまざまなカラムに対応する複数
のテキスト文字列に基づく syslog
メッセージフィルタリング。

•カスタムフィルタの作成。

•メッセージのカラムによるソー
ト。詳細については、『ASDM構
成ガイド』を参照してください。

この機能は、すべての ASAバージョ
ンと相互運用性があります。

次の画面が変更されました。

[Monitoring] > [Logging] > [Real-Time
Log Viewer] > [View]。

[Monitoring] > [Logging] > [Log Buffer
Viewer] > [View]。

8.4(1)syslogメッセージのフィルタリングと
ソート

ASA 5580および 5585-Xのクラスタリ
ング環境での syslogメッセージ生成の
サポートが追加されました。

次の画面が変更されました。
[Configuration] > [Logging] > [Syslog
Setup] > [Advanced] > [Advanced Syslog
Configuration]。

9.0(1)クラスタ

フェールオーバーコンフィギュレー

ションのスタンバイ装置で特定の

syslogメッセージの生成をブロックす
るためのサポートを追加しました。

次の画面が変更されました。
[Configuration] > [Device Management] >
[Logging] > [Syslog Setup]。

9.4(1)スタンバイ装置の syslogのブロック

TCPと UDP経由で syslogを記録、送
信、受信するために、syslogサーバを
IPv6アドレスで設定できるようになり
ました。

次の画面が変更されました。
[Configuration] > [Device
Management] > [Logging] > [Syslog
Servers] > [Add Syslog Server]

9.7(1)syslogサーバでの IPv6アドレスのサ
ポート
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